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Figure 1: ReLaTe Main Wlndow

The RelLaTe Integrated Interface is an application that combines all the video
conferencing components into one single user interface. These components
consist of the audio tool ‘RAT’, the video tool ‘VIC’, the shared text editor
‘NTE’ and the shared whiteboard ‘WBD'.

I The latest versions of the tools (from the UCL Multimedia Homepage) are
required for the interface to function correctly. At the time of writing, these
are:-

« RATV3.2.6

e VIC v2.8ucll
e WBD v1.0ucll
« NTEvV1.5.31

1.1 Getting started
Unix:

Type the following from the command prompt:-

Prompt> relate
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Windows 95/98, NT4.0:

Click on the Start button in the bottom left hand corner of the screen.
Select Programs, then Mbone Tools and finally ReLaTe Integrated
Interface.

1.2 Quick guide to using ReLaTe

When you start up RelLaTe, you will get a small window where you can enter
your name, telephone number and email address or edit the details if they are
already filled out (see Figure 2).

RelLaTe =]

Welzome to BelaTe | Pleaze check your hame and email addrezz as they will be
uzed to identify vou in this conference. [f they are incorrect click in the box and
change them az necessary. Femember to uze pour real name and affiliation inztead
of a ‘handle’, e.a., \lane Doe [ACKME Research)'.

Full Mame:  [John Smith
Email &ddress: ). Smith@ucl.ac.uk
Telephone Mumber:  |0171 123 4567
Lozation: | LICL

Figure 2: ReLaTe Initial Window

Press the More button to get a ReLaTe Configuration Window where you can
put in the address, port number and ttl for each of the tools (see Figure 3).
You can also disable any of the tools by deselecting its entry in the required
column. You might want to start up with only the audio and text editor, for
example.

The multicast address should be in the range 224.2.0.0 - 224.2.255.255. The
port should be at least 5002.

RelaTe: Configuration. .. M=l E

bools addrezs pork tl required
whiteboard  [224.9.9.9 [tooon— [i6 =
testeditor  [224.9.9.9 [z0000  [16 [

video  [224999 [30000  [16 '

sudio  [224.9499 [40000  [16 v

Figure 3: ReLaTe Configuration Window
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£ All participants must use the same addresses and port for each of the
tools in order to “see” one another. The addresses for all of the tools may
be the same, but the ports must be different for each tool.

The ttl should be 16 for conferences where all participants are in the same
building, 48 if they are all in the UK, 63 if they are all in Europe and 127 for
the rest of the world.

Once you are happy with the addresses, ports and ttl values for the tools,
press the Done button in the ReLaTe Configuration Window, and then press
the Accept button in the initial window.

ReLaTe will now start up. This will take a short while as the tools will be
started up separately and eventually be combined into the single interface.

When shutting down RelLaTe, you should press the Quit button in the bottom
right hand corner of the interface. If you quit by pressing the cross in the top
right hand corner, the underlying audio, video and shared workspace tools will
not be closed down correctly.

Audio

To listen to what the other participants are saying, you should use the audio
controls which are at the bottom of the Main ReLaTe Window (see Figure 1).

The top slider bar is for controlling the volume of what you hear through the
speaker or the headphones. You must turn the volume up in order to hear
what other participants are saying by moving the top slider bar to the right.

The button slider bar is for controlling the volume of your microphone. In order
to speak , you must depress the mute button which is just left of the button
with the microphone icon.

Ideally, you should use headphones, as these enable you to speak and listen
at the same time. If you are using speakers, you must mute your microphone
by pressing the mute button next to the microphone whenever you are not
talking. If not, everybody will hear an echo.

Video

You can choose between having up to 4 or up 8 people sending video at the
same time (including yourself). The default maximum is 8. When you are
having up to 8 video streams at the same time, all the images will be a set
size. If you choose to have up to 4 people at the same time, one of the
images can be enlarged. You can select a maximum of 4 participants by
clicking on the Participant button at the bottom of the screen and select four.

To transmit video check the Transmit button in the bottom left-hand corner of
Main ReLaTe Window.
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To stop transmitting video  press the Stop button in the bottom left-hand
corner of the Main ReLaTe Window. When you stop transmitting, your video
window will not go away, it will just freeze but it will eventually disappear.

To enlarge a video image (this is only possible if a maximum of 4 participants
have been selected), click on the grey area immediately above the image you
would like to enlarge. It will then appear in the square on top of the little
images. You can only enlarge one window at a time, but you can change
which window is enlarged at any one time.

To "tidy up" the video images, press the Refresh button at the bottom of the
screen. This will close down pictures that are no longer active.

Shared Text Editor - NTE

Text that is typed in or imported into the text editor by other participants will
automatically be displayed in the Main NTE Window. If the text takes up more
than one screen, you can use the scroll bar on the right of the text area to
scroll up and down.

In order to write in NTE, click anywhere in NTE and start typing. The text will
begin from where you initially clicked.

You can edit text by clicking on the text you want to edit and then using the
keyboard to make the changes.

Shared Whiteboard - WBD

WBD allows you to draw as well as type. It is a shared drawing tool with
limited text functionality. You get the whiteboard by clicking on the Work-
space button in the bottom left hand corner of the of the ReLaTe interface.
You can switch between the two shared workspaces at any time during a
conference, allowing you to make the best use of each of them for specific
purposes.

I Remember patience is important! - if you do not get immediate reaction to
your actions in WBD, wait a couple of seconds before attempting again.

Text or drawings created by other participants will automatically be displayed
in your WBD Window.

To write on the WBD, select the button labelled "T", and type using the
keyboard. Your text will appear where ever the mouse is.

I If you move your mouse while typing, the letters will be scattered over the
page, following the mouse.

To draw on the WBD, select the button labelled with a feather, and draw
using the mouse.

£ If nothing appears on the screen when you try to write or draw, check that
the right icons in the right hand side of the WBD has been selected and
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check that the colour you are writing with is different from the background
colour.

You can use the controls on the right hand side of the keyboard to draw
various shapes (straight lines, arrows, squares and circles). You will also find
options to move and copy text or drawings, change the font of writing, change
the thickness of the brush for drawing, change the colour that you use for
drawing and writing, change the orientation of the whiteboard.

You can use the controls at the bottom of the whiteboard to select a blank
page, import postscript and text files and browse through the pages if there
are more than one pages to the document.

£ WBD will always switch to the page where someone is currently writing or
drawing. So if you select a Blank Page and start typing on it, all of the
other session participants will automatically switch to the page you are
now typing on.

You should now be able to use ReLaTe for taking part in conferences.

1.3 RelaTe User Guide

The RelLaTe interface consists of four individual tools (VIC, RAT, NTE and
WBD) which have been altered slightly and put into a common frame. The
tools work independently of one another, so it is possible for one tool to crash
without affecting the others. In effect, the ReLaTe interface removes the
burden of windows management that running three tools separately causes.
In this section we shall go through the four tools used by RelLaTe separately.

1.3.1 Audio (RAT)

See Figure 4 for what the audio controls look like.

The top slider bar is for adjusting the volume of the sound that you hear
through the speakers or headphones. The bottom slider bar is for adjusting
the volume of your microphone.

The top mute button is for stopping sound coming through the speakers or
headphones. The bottom mute button is for muting your microphone, i.e. to
stop the other participants from hearing what you are saying. When the mute
button is pressed down, i.e. muted, the icon next to it will be greyed out.

I If you are not using headphones, you must mute your microphone when
you are not talking. So before you say something, unmute your
microphone, and as soon as you have finished talking, mute the
microphone again.

b ) A B
,leuhl Tesrerenion o rabed
bty [lpnnm dint FAT |
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Figure 4: ReLaTe Audio Controls

If you want to adjust any of the audio settings, click on the Audio Options
button, and you will get the RAT Preferences Window. Many of these options
do not need to be changed but you might need to change one of the following:

» If other participants complain that your audio keeps cutting out, try turning
off Silence Suppression, under the category ‘Transmission’. If you turn
silence suppression off, you should use push-to-talk.

* If you are only listening, for example to a lecture, you should turn on
Lecture Mode, under the category ‘Reception’. When you talk Lecture
Mode is automatically switched off.

* If you want video and audio synchronised then you should turn on Video
synchronisation , under the Category ‘Interface’. You may notice more
delay from other participants when using this option.

Click on the button labelled ‘Save and Apply’ to save and use your changes.

1.3.2 Video (VIC)

See Figure 5 to see what the ReLaTe video section looks like. The ReLaTe
interface allows up to 4 or 8 participants to send video. There is no limit to
how many participants can use audio and shared workspaces at the same
time. You can select the maximum number of participants by clicking on the
Participants in the bottom left hand corner of the ReLaTe interface and
selecting four or eight.

To enlarge a video image (this is only possible if a maximum of 4 participants
have been selected), click on the grey area immediately above the image you
would like to enlarge. It will then appear in the square on top of the little
images. You can only enlarge one window at a time, but you can change
which window is enlarged at any one time

To start transmitting video , press the Transmit button in the button left hand
corner. The little white box will be checked and your image will appear in one
of the little squares above the controls.

To stop transmitting video , press the Stop button next to the Transmit
button. When you stop transmitting, your image will not disappear form the
screen, it will just appear frozen. Your image will only disappear from
everybody's screens when you exit ReLaTe. You can make it disappear on
your own screen by clicking the Refresh button.

To alter the setting of the video, press the Admin button, and the VIC Menu
Window will be displayed. The options you are most likely to use are:
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If you want to adjust the number of frames per second and kilobits per
second you are transmitting, you can do so on the slider bars to the right
of the Transmit button.

If you want to see a list of all the people running VIC on the address/port,
click the Members button. (You can only see people who are transmitting
video in the ReLaTe window. The Members button is the only way of
telling how many people are watching).

If you need to confirm the address, port, ID and ttl of VIC for the session,
that information can also be found in the VIC Menu Window.

ami dpuy pow oW

Sy sk

|Ezhn  idEben D [ oW dedE rnu-nm-l‘u
e [ | man o] e | s |

Figure 5: ReLaTe Video Controls

The following information is displayed under each image:

<number> f/s: This tells you how many frames per second you are
receiving from that person. In Figure 5, you are receiving 7 f/s from “David
(Harrow)” in the large window, 8.4 f/s from Sofia etc. They may all be
transmitting a maximum of 8 frames per second, but as the video has to
travel over the Internet, there is no guarantee that you will receive 8
frames per second.

<number> kb/s: This tells you how many kilobits per second you are
receiving from each person. As with the frames per second, this number is
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dependent on the network and may well be different from what they are
transmitting.

* (<number> %): This tells you how much packet loss you are receiving from
each person, i.e. how much of the video information that each person is
transmitting does not get through to you.

e M: This allows you to “mute” the images. When you mute an image your
computer will no longer decode the video images that it receives. The
image will appear frozen on the screen. You can mute your own image,
but remember that even though it appears frozen on your own screen, it
will NOT be frozen on the other participants’ screens unless they
themselves mute your image. Muting the images may sometimes be
necessary if your computer cannot cope with updating all of the video
streams, which can require a substantial amount of computing power.

1.3.3 Text (NTE)
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Figure 6: ReLaTe Shared Text Editor

All the text in NTE appears in the main editing window which is the big white
part of the Main NTE Window. Text in NTE is treated as blocks.

To create a block of text , simply click with the left mouse button on a blank
space, and start typing. If the screen is full and you cannot use the scroll bar
to move further down the document a block of text should be created right at
the bottom of the screen and the Enter key on the keyboard used to create
more space for typing.
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A block of text can be manipulated in different ways:

* You can change the colour of the block by selecting the block by clicking
on it and choosing a colour from the Colour menu at the top of NTE.
Colours are primarily to distinguish between different people editing the
same document. You cannot set parts of a block to different colours - only
the whole block. You can give your pen a default colour by choosing a
colour from the Colour menu before you type anything.

* You can change the font into italics and/or bold by selecting the block by
clicking on it and choosing a font from the Font menu at the top of NTE.
The limited selection of fonts is to enable documents to be saved as plain
text, without the problems that would result from variable width fonts. The
different font styles are available to help distinguish different users’ texts.
You can only change the font of an entire block, not parts of it.

* You can move a block by selecting the block by clicking on it and holding
down the Ctrl key on the keyboard and dragging the block of text with the
left mouse button.

* You can delete a block by selecting the block by clicking on it and
selecting Delete Block from the Edit menu at the top of NTE.

» If two blocks of text are on top of one another, you can lower the block on
top, i.e. make it go in the background, by selecting the block by clicking on
it and selecting Lower Block from the Edit menu.

To edit an existing block of text, select the block of text by clicking on it with
the left mouse button. It is possible to edit the text of others as well as your
own -unless they have locked their contributions.

Several people can work on the same block of text at the same time.
However, a block can only have one colour, font and location at any one time,
so it is not possible to highlight one person’s contribution to that particular
block by using a different colour or font.

When the Current Block Info option in the Show Menu is selected, a line is
visible underneath the menu at the top of the screen displaying information
about the block which you have currently selected. It will tell you the block id
number, who created it, who last edited the block, and when it was last
changed. A padlock after the block id tells you whether the block is locked or
not. If it is locked, only its creator can edit the block.
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Attracting Attention in the Text

If participants have to scroll to see the whole text because it is bigger
than the window it is displayed in, there is no easy way of making sure
that everybody is looking at the same part of the text. If you want to
draw everybody’s attention to a certain place in the text, you can hold
down the right mouse button which will display a pointer on everybody
else’s screens - but only if they are already looking at that part of the

Q text!

If another participant is pointing to a part of the NTE which is not
currently displayed in the window, a stripe, the same colour that the
participant is currently writing with, will appear in the document map
(Displayed in the bottom right hand corner of the Main NTE Window).
The document map is only available if Current Block Info has been
selected in the Show menu.

Alternatively, you can mark the text by inserting special characters like
a row of exclamation marks which can be easily found when scrolling
up and down the text.

Box 1: NTE - Attracting Attention in the Text

£ Itis generally a good idea for each participant to write with a different
colour so that it is easy to identify who is writing what.

Saving and loading text

It is possible to save the blocks of text on the whiteboard in a file for later
reference. It is likewise possible to load plain text files into NTE.

* You can save text by choosing Save Plain Text from the File menu. (The
Save Structured Text option is not available).

e You can load text by choosing Load Plain Text from the File menu.

However, there is a limit to how big a text file you can load. If the file is too
big, it will automatically be truncated. (The Load Structured Text option is
not available).

If you load two or more texts, they will all appear in the top left hand corner

of the window, so you will end up with two or more texts on top of one
another. You can move the texts by holding down the Ctrl key on the
keyboard and dragging the block of text with the left mouse button.

I If there is more than one block of text, there is a risk that the blocks may
be aligned differently in other participants' NTEs.

Other options

By holding down the right mouse button, a pointer visible to the other
participants will appear. When you right click, the pointer on your screen will

10
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say me (see Box 1: NTE - Attracting Attention in the Text), but to everybody
else, the pointer will contain your user name.

A Ctrl + Left (Windows only) or middle (Unix only) Mouse Button: Grab

NTE Mouse Bindings

Left Mouse Button: edit an existing block, or create a new block if no
existing one is under the pointer.

and move an existing block.

Right Mouse Button: Send a shared pointer that the other participants
can see.

Box 2: NTE Mouse Bindings

If the Participants option in the Show menu is selected, a column will appear
at the right of the screen, containing a list of participants , a small control
panel, and a document map .

At the top, a list of the participants in the conference is shown in their
current colour. When a participant has not been heard from recently, their
name is displayed in grey, and will eventually be removed. If the Keep
button is selected, participants will remain in the list of participants despite
no longer being active.

Underneath the list of participants is a small control panel giving you
three options.

If you select Read only, you cannot write anything. This is a useful option if
you do not wish to accidentally write or delete something in NTE.

If you select Lock New Items, only you can edit and delete the blocks that
you have created. This only applies to blocks created while this option has
been selected. The option is useful if you want to import or type in some
text which you do not want anybody else to edit or delete. If anyone apart
from the creator of the block attempts to edit your text they will see a small
padlock symbol.

Encrypt Sessions allows you to encrypt the text in NTE so only participants
with the right password can read the contents of NTE. You will be asked to
enter a password for the session if you select this option. Then whenever
other users wish to join the session they will have to enter the correct
password before being allowed to join.

The grey and white square at the bottom right hand corner of the screen is
a document map . The white area represents the part of the document
which is currently visible. If the document map is all white, you are seeing
the entire text on the screen. But as the text gets longer, you will need to
use the scroll bar to move around in the text, and the white area in the

11
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square gets smaller. The bigger the document, the smaller the white area.
If the white area is at the top of the square, you are looking at the top of
the text. The document map will give you an indication of when other users
are modifying the document in an area that is not locally visible by
displaying a coloured bar where the editing is taking place.

You can access a help text by clicking on the Help button in the top right hand
corner of the Main NTE Window.

1.3.4 Whiteboard (WBD)

Whiteboard H=lE

For moving text or drawings e

To delete: For copying text or drawings Eopy
Point to the item you would like to delete For typing text

and left click while holding down the

For making freehand drawings
Ctr]l key on the keyboard

For drawing straight lines

For drawing arrows

For drawing squares

OO N &l-

For drawing circles

For selecting colour for drawing or typing Calour

For selecting the width of the brush for drawing | wig

=

a3

For getting a new page For selecting the font for typing Fo

= . = D
For importing PostScript files For changing the orientation to normal landscape
For changing the orientation to normal portrait H]
For importing text files For changing the orientation to upside-down landscape| O
For changing the orientation to upside-down portrait 0
Scroll bar for changing hetween pages
MHew Page | Import P& |Impon Tenl Grab | <I I ’I Quit

Figure 7: Main WBD Window

To type : Select the button labelled "T" in the Main WBD Window. Position
your mouse pointer where you would like your text to appear and type
using the keyboard. If you move the mouse while typing, the letters will
still appear wherever the mouse pointer is!

12
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Useful WBD Control Characters:
 BACKSPACE will delete the last typed character

» Carriage return will start a new line under the start of the
A previous line

* CTRL-left mouse click will delete the text or drawing under the
mouse pointer

Box 3: Useful WBD Control Characters

To draw : Select the appropriate icons for what you want to draw (Figure 7:
Main WBD Window). Using any of these tools is essentially the same
as using any basic drawing program.

To delete : Point to the text or drawing that you would like to delete. Then hold
the Ctrl button down on the keyboard and left click on the mouse.

£ You can only delete your own contributions in this way.

If you want to delete other participants’ text or drawing, you have to “paint
over” them. If the background colour of the WBD is white, you can select
one of the drawing icons and the colour white, and use the mouse to paint
on top of the text or drawing that you want to delete. (Remember to switch
to another colour again for writing and drawing.)

£ You cannot edit text once you have finished writing it, i.e. moved your
mouse elsewhere.

£ You cannot edit other peoples text

To change the text font: Click on the Font button on the right hand side of
the Main WBD Window and select a font from the menu.

To change brush size (for drawing):  Click on the Width button on the right
hand side of the Main WBD Window and select a brush size from the
menu.

Your cursor

Only you can see your mouse cursor. To point to something you must
make a mark on the page - underline, circle or draw an arrow pointing
A to it. You can erase this pointer subsequently.

Box 4: WBD cursor

13
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To change the colour (for text and drawing): Click on the Colour button in
the right hand side of WBD and select the colour you want on the
colour palette. It is normally a good idea for each participant to use a
different colour so that it is easy to see who is writing or drawing what.

£ You cannot change the colour of text or drawings already in the WBD, only
text or drawings that you are about to make.

To change the orientation of the whiteboard: Click on one of the four
bottom most buttons on the right hand side of the Main WBD Window,
depending on which orientation you want (see Figure 7: Main WBD
Window).

I You cannot save or print the contents of the WBD.

To get a new blank page: Each page in the whiteboard is a set size - it does
not have scroll bars. So if you run out of space, you can get a new
page by clicking the New Page button in the bottom left hand corner of
the Main WBD Window. Wherever you are when you create a new
page WBD will automatically move you on to the new page. If you are
on page 2 of 10 pages currently created, the new page will be page 11
and you will be moved to it.

Hints on use

* Itis a good idea to begin by typing your name. It is also helpful if all
participants choose a unique font/colour combination. This makes
it easier to distinguish individual's contributions and reduces the
need to sign or initial each contribution.

 WBD is a shared whiteboard, and does not provide the

A functionality of a general purpose drawing tool. If you need quality
slides or diagrams, it is best to prepare them beforehand in

minimal PostScript format (for example using "idraw") and import

them into WBS using the Import PostScript function provided.

¢ Creating new pages by clicking the New Page button is faster than
erasing the current page. It has the additional benefit of
maintaining the previous pages for future reference.

Box 5: Whiteboard Hint for Use
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Further Reading

For further information about the JANET Mbone service, see the
JANET Mbone Service Technical Guide. The guide is available from:
http://www.ja.net/documents/mbone3.4.ps

The following user guides are available from:
http://www-mice.cs.ucl.ac.uk/multimedia/software

User Guide for RAT v3.2
User Guide for VIC v2.8
User Guide for WBD v1.0

User Guide for NTE v1.5
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Glossary

Bandwidth
A term used to show the amount of information flowing through a communications
channel. Expressed in units of n x1000 bits per second, kbit/s.

CellB

A proprietary low bit rate video encoding developed by Sun Microsystems.

CIF
Common Image Format, fitting an image into dimensions of 352x288 pixels.
CODEC
COder/DECoder. A hardware or software processor converting between analogue
audio or video and the digital format used for transmission, in both directions. The
term is also used to describe the major hardware component of a videoconferencing
system.
DES
Data Encryption Standard.
DVI
Audio encoding standard.
Framegrabber

A device which captures video one frame at a time from an analogue video source.

Frames per second (fps)
The frame rate for video image transmission, measured in frames per second (fps).
The higher the frame rate, the better the motion rendition of the video image. 30 fps is
the standard necessary for full motion video. To date, most communication channels
are not capable of transmitting large numbers of video streams concurrently. With
compression and the use of other signal processing algorithms, a videoconferencing
VIC between 2 - 10 kilobits per second (kbit/s) is perfectly acceptable.

Gamma correction

Gamma correction is the correction of intensity values of cameras and monitors. In
the context of displays, the luminescence of phosphor pixel is a non-linear function of
the intensity of the electrons bombarding it. Conversely, both film and CCD cells
have non-linear photon intensity versus recorded intensity functions. Gamma
correction is a non-linear correcting function to overcome these problems.

GSM
Audio encoding standard.

H.261
ITU-T video encoding standard in narrowband audiovisual systems.

IP address
IP (Internet Protocol) addresses are unique numerical identifiers for each networked
host computer. The IP address is used in conferencing when the conference is point-
to-point rather than multiparty.
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JPEG

Video encoding standard for still images. It has a high compression rate; it computes
by dithering and losing “unnecessary” information, hence considered lossy. Decoding
speed can be traded off against image quality.

Kilobits per second (kbit/s)
The kbit/s rate enables the participants to track how much bandwidth is being used
during a session. For videoconferencing, the kbit/s should not be raised above 128
kbit/s, unless using a point-to-point conference or a Local Area Network (TTL=16).
See TTL.

LBL
Lawrence Berkeley Laboratories, University of California, Berkerley, USA.

Lecture mode
An optimisation for one-way transmission which increases the delay on the layout of
the media in order to minimise the loss of data in the network. The longer the playout
is delayed, the more time there is to retransmit lost packets.

Loss Rate
The percentage of packet information lost during transmission.

LPC
Audio encoding standard. Linear Predictive Coder, 9 kbit/s.

Mbone
The multicast capable backbone of the Internet. It currently consists of a network of
tunnels linking the islands of multicast capable sub-networks around the world.

MJIPEG
Motion JPEG. The use of JPEG to encode motion video. A number of manufacturers
have developed M-JPEG systems. There is no systems level standard for M-JPEG
systems, and different manufacturers’ systems will not interoperate.

MPEG
Motion Picture Experts Group.

MTU

Maximum Transmission Unit. A measurement, in Bytes, of the largest packet size
which a network is capable of transmitting.

Multicasting
Multicasting is sending audio, video etc. on the Internet in way which ensures that
anybody who is interested in receiving the information, can receive it, but only people
who are interested will receive it. Think of it as being in between unicast (like most
telephone calls - between two telephones only) and broadcast (TV - the signals are
sent to you whether you want to watch or not).

Multicast address
Addresses used for multicast conferencing should be in the range 224.2.0.0 -
224.2.255.255
Note: Multicast addresses must be agreed upon in advance of the multicast session,
either through e-mail or phone or assigned using SDR.

Network congestion
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A condition in an IP network where the amount of traffic injected into the network is
too great for the routers to handle and some packets are discarded.

NTE
Network Text Editor.
NTSC
National Television Standard Code. The television encoding used in the USA.
NV
Network Video. A software package, in the public domain, which supports
videoconferencing over Internet Packet Networks.
PAL
Phase Alternate Line. The television encoding used in Europe.
PCM
Audio encoding standard. Pulse Code Modulation, 64 kbit/s 8-bit p-law encoded 8
kHz.
Port
A UDP (User Datagram Protocol) number unique to the broadcast session, and
should be over 5000.
Note: The port number must be agreed upon in advance, either through e-mail or
phone or assigned using SDR.
Protocol
A set of standards that govern the transfer of information between computers over a
network or via telecommunications systems. To reduce errors, the computers at both
ends of a communications link must follow the same protocol.
QCIF
Quarter Common Image Format with dimensions of 176x144 pixels.
RAT

Robust Audio Tool.

Receive-only
A condition where a tool is used to receive information, but cannot transmit.

Redundant audio encoding
Also known as redundancy. A technique to protect against packet loss where a
second, low bandwidth version of the original encoding is piggy-backed onto the
preceding packet so that, when single packets are lost, the redundant version is
played back instead of silence.

RTP

Real-Time Protocol is an application level protocol that provides real-time support for
multimedia communication.

RTIP
Real-Time Internetwork Protocol.

SCIF
Super Common Image Format with dimensions of 704x576 pixels.
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SDR

Session Directory Tool.

Silence suppression

Silence suppression is used in packet voice systems to reduce the output bandwidth
of an audio system by exploiting the on-off nature of speech; 50% savings are
possible.

SIP
Simple Internet Protocol.
TTL
TTL stands for time to live, and determines how far multicast packages can travel
over the Internet. The standard values are:
16 - Site
47 - UK
63 - Europe
127 - World
Unicasting
A unicast connection is a point to point connection between two specific machines.
VAT
Visual Audio Tool.
VIC
Video Conference tool. The tool included in the RELATE package for the
transmission and reception of video streams.
WBD

Whiteboard.
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